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Your laptop could catch fire!

You may have heard that Sony is recalling some lithium-ion 
laptop batteries after at least 47 laptop computers overheated 
and some actually caught fire.

 http://www.cpsc.gov/cpscpub/prerel/prhtml06/06271.html

You may not have heard that other brands of laptop could be 
affected. Here's how:

Despite  the  brand-name  on  your  computer,  it  wasn't 
necessarily built by that company. For example, your Apple, 
Dell, Fujitsu, Gateway, HP, IBM, Sharp, or Sony laptop was 
probably  assembled  by  the  Taiwanese  laptop  company 
Quanta  Computers.  Its  screen  was  probably  made  by  LG 
Philips,  Samsung,  AU  Optronics,  or  Chi  Mei,  while  the 
battery was probably manufactured by Sanyo, Matsushita, or 
the Sony Energy Devices Corporation. It is that last that is at 
the heart of the problem.

Approximately  10  million  lithium  ion  laptop  batteries 
manufactured  by  Sony  have  the  potential  of  overheating, 
possibly  resulting  in  a  fire.  These  potentially  defective 
batteries can be found not only in certain Sony laptops but 
also in  certain  laptop models sold by Apple,  Dell,  Fujitsu, 
Gateway, Hitachi,  IBM/Lenovo, Sharp, Sony, and Toshiba. 

Hewlett Packard and Acer also use Sony batteries but at the 
time of writing hadn't issued a recall on any of their laptop 
products.

The  laptops  affected  were  all  marketed 
within the last year, so, if you didn't buy a 
new laptop in that period, you need only 
observe  the  following  safety  tips, 
which  come  from  the  US 
Consumer  Product  Safety 
Commission. (Italicised additions 
are mine throughout.) 

If, however, you did buy a new laptop, whether or not it is of 
a  brand mentioned above, check with the supplier whether 
there has been a recall.

Laptop safety tips

Do not use incompatible computer batteries and chargers. If 
unsure  about  whether  a  replacement  battery  or  charger  is 
compatible, contact the product manufacturer. 

• Computer batteries can get hot during normal use. 
Do not use your computer on your lap [without a 
ramp to allow air circulation]. 

• Do not use your computer on soft surfaces, such as a 
sofa,  bed or  carpet,  because  it  can restrict  airflow 
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and cause overheating. [If you must use a laptop in 
such circumstances, try using a 'stable table' and a  
ramp  under  the  computer  to  ensure  adequate  air 
circulation.]

• Do not  permit  a  loose  battery  to  come in  contact 
with metal objects, such as coins, keys or jewelry. 
[Contact with such objects could cause an external 
short circuit, damaging the battery.]

• Do  not  crush,  puncture  or  put  a  high  degree  of 
pressure on the battery as this can cause an internal 
short-circuit, resulting in overheating. 

• Avoid dropping or bumping the computer. Dropping 
it, especially on a hard surface, can potentially cause 
damage to the computer and battery. If you suspect 
damage contact the manufacturer. 

• Do not place the computer in areas that may get very 
hot. [E.g. In the sun, or near a heater.]

• Do  not  get  your  computer  or  battery  wet.  Even 
though they will dry and appear to operate normally, 
the circuitry could slowly corrode and pose a safety 
hazard. 

• Follow  battery  usage,  storage[,  disposal] and 
charging guidelines found in the user’s guide [or on 
the  manufacturer's  website,  if  you  don't  have  a 
guide.] 

Index

Blue screen of death screensaver

With delicious irony, Microsoft TechNet now offer a “Blue 
Screen  Of  Death”  (BSOD)  screensaver.  This  came  about 
when MS bought SysInternals earlier this year and made the 
SysInternals utilities available through TechNet.

The screensaver puts up a BSOD that looks Very Very Real - 
in  fact,  it  uses  actual  system  data  from  your  machine  to 
customise it so that it looks even more real. And every fifteen 
seconds,  it  simulates  an  attempt  to  reboot  resulting  in  ... 
another BSOD.

An excellent screensaver to install on shared systems.

Download it at 

http://www.microsoft.com/technet/sysinternals/Miscellaneou
s/BlueScreen.mspx

Thanks are due to Robin Johnson for passing on that one. 
Pity it isn't 1st April. Everyone would have thought we were 
having them on!

Here's  an  extract  from  the  Microsoft  TechNet  website 
concerning the screensaver:
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One of the most feared colors in the NT world is blue. The  
infamous Blue Screen of Death (BSOD) will pop up on an NT 
system  whenever  something  has  gone  terribly  wrong.  
Bluescreen  is  a  screen  saver  that  not  only  authentically 
mimics  a  BSOD,  but  will  simulate  startup  screens  seen 
during a system boot. 

• On NT 4.0 installations it simulates chkdsk of disk 
drives with errors!

• On Win2K and Windows 9x it presents the Win2K 
startup  splash  screen,  complete  with  rotating  
progress band and progress control updates!

• On  Windows  XP  and  Windows  Server  2003  it  
present  the  XP/Server  2003 startup  splash  screen 
with progress bar!

Bluescreen  cycles  between  different  Blue  Screens  and 
simulated  boots  every  15  seconds  or  so.  Virtually  all  the  
information shown on Bluescreen's BSOD and system start  
screen  is  obtained  from  your  system  configuration  -  its  
accuracy  will  fool  even  advanced  NT  developers.  For  
example,  the NT build  number,  processor  revision,  loaded 
drivers  and  addresses,  disk  drive  characteristics,  and 
memory  size  are  all  taken  from  the  system  Bluescreen  is  
running on. 

Use  Bluescreen  to  amaze  your  friends  and  scare  your 
enemies! 

Bluescreen  runs  on  Windows  NT  4.0,  Windows  2000,  
Windows  XP,  Windows  Server  2003  and  Windows  9x  (it  
requires DirectX). 

Note: before you can run Bluescreen on Windows 9x,  you 
must  copy  \winnt\system32\ntoskrnl.exe  from  a  Windows 
2000 system to your \Windows directory.1 

Simply copy Sysinternals BLUESCRN.SCR to your \system32 
directory  if  on  Windows  NT/2K,  or  \Windows\System 
directory if  on Windows 9x.  Right  click on the desktop to  
bring  up  the  Display  settings  dialog  and  then  select  the  
"Screen  Saver"  tab.  Use  the  pull  down  list  to  find 
"Sysinternals Bluescreen" and apply it  as your new screen 
saver.  Select  the  "Settings"  button  to  enable  fake  disk  
activity, which adds an extra touch of realism! 

1 If you don't have access to a Windows 2000 system, try the copy available 
from: http://members.driverguide.com/driver/detail.php?driverid=30670
It may be suitable, but I haven't tested it..

When you go to  Microsoft  to  download your  copy of  the 
screensaver, have a look at the other utilities that MS have 
acquired  with  SysInternals.  Some  of  them  could  be  quite 
useful. While they are principally aimed at the professional, I 
spotted two or three that a reasonably experienced user might 
have occasion to employ.

Index
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Linux for the modern laptop

What I looked for

When I  tried Xandros  4.0 on my laptop,  the clock started 
gaining  rapidly  and  the  sound  didn't  work  properly.  No 
doubt, someone who spoke fluent “LinuxGeek” could have 
steered me towards suitable fixes, but I decided to see if I 
could find a Linux distribution (commonly called a “distro”) 
that  would  run  the  laptop  perfectly  “out  of  the  box”, 
especially  the  clock,  the  sound  chip  and  my  inbuilt  and 
PCMCIA wireless links. I also wanted to be able to install 
additional software without hassles and to be “comfortable” 
with  the  way  the  installed  distro  functioned.  That  last  is 
entirely subjective and what suits me may well not suit you.

Freespire, Xubuntu, Kubuntu?

I tried Freespire, but it failed to recognise the sound chip. I 
tried Xubuntu, but didn't like the Xfce interface, nor the way 
new applications were added. I  tried Kubuntu which has a 
KDE  desktop,  as  does  Xandros.  However,  Xandros  has 
enhanced  the  KDE  desktop,  added  some  well  integrated 
proprietary utilities of its own, and amended menus to make 
them more  intelligible  to  a  Windows user.  Kubuntu  didn't 
come close and the choice of Adept-installable applications 
was somewhat limited, which was a surprise given the huge 

number available from Debian. 

Italian dessert?

Then I  tried an Italian dessert  –  or,  rather,  a  Linux distro 
named after one. Sabayon, as it was called, had an attractive 
colour  scheme,  used  two taskbars  –  one  at  the  top  of  the 
screen and one at  the bottom – and appeared to  drive the 
laptop  properly.  Being  Gentoo-based,  it  used  a  different 
method of installing applications, but I still struck problems. 
Another “coaster” for the collection!

SimplyMEPIS?

Then I decided to try the latest version of SimplyMEPIS. I 
had tried a previous version of this distro on my desktop and 
thought it  might be worth a  look. I  found that  the MEPIS 
developers had linked up with Ubuntu and used both Ubuntu 
and Debian as sources. As a result, MEPIS offers one of the 
largest selections of additional applications. 

I downloaded the single CD version from Internode. As an 
Internode customer, anything I download from the Internode 
mirrors is unmetered and doesn't count toward my monthly 
quota, but I didn't want to take the time to download the full 
three CD version. I burnt the ISO file onto a CD and ran it.

Like many Linux distros, MEPIS allows you to test it by first 
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running it  “Live”, booting and running from the CD and a 
RAMdrive that it sets up in your computer's memory. Sound 
worked, clock behaved, wireless network running, Kpackage 
and Synaptics for additional applications. Looked like a goer 
so I tried to install it by clicking on the desktop icon provided 
for the purpose. No matter what I did, it would not install. 
Then I realised why.

To  install  applications  and,  in  this  case,  Linux  itself,  you 
must  have  “root”  or  “administrator”  privileges.  I  rebooted 
into the “root” account and it installed without any problems. 
I  then began adding applications. There were two different 
systems,  but  I  managed  to  navigate  my  way  around  and 
install a selection of applications.

The Launch menu was somewhat peculiar in that it gave the 
description  of  the  application  followed  in  brackets  by  the 
name of the application. If you deleted the description using 
the  menu  editor,  the  name  was  displayed  without  the 
brackets.

As SimplyMEPIS is Debian-based, I was able to configure it 
to  resemble  Xandros  –  all  that  were  missing  were  the 
proprietary additions, such as Xandros File Manager.

SimplyMEPIS proved quite usable, but, somehow, still wasn't 
what I was looking for.

Mandriva One

Mandriva used to be called Mandrake until the Mandrake the 
Magician publishers objected. Around that time, Connectiva 
merged  with  Mandrake  and  the  name  was  changed  to 
Mandriva.  Another  acquisition  was  Lycoris  and  Mandrake 
One incorporates some technology from that distribution. So 
I thought I would try that.

It installed simply enough from the one CD, (the ISO file of 
which I  downloaded and burnt  to  CD),  came with a  good 
selection of applications, but no games, and ran quite well on 
my laptop. 

It  was  when  I  went  to  add  more  applications  that  I  was 
confronted  with  thousands  of  “packages”  -  not  complete 
applications,  but  the  components  that  the  applications  are 
installed  from.  With  Freespire,  Xandros  and  Lycoris  you 
choose  an  application  with  a  couple  of  clicks  and  it 
downloads  and  installs,  taking  care  of  all  this  package 
business without any input from you. Not so Mandriva One, 
despite the Lycoris technology. Again, not something that I 
could recommend to a novice moving from Windows 98.

Next  issue we'll  conclude this look at  various distros with 
some advice on how to choose one.

Index
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Removing line breaks

When you paste part of an email or a webpage into a word 
processing document, you often find that the text doesn't flow 
or wrap around. What can you do about it? Firstly, you could 
manually join the lines together by adding a  space to each 
line and then pressing the DELETE key. That's OK for a few 
lines, but quickly becomes a pain if the inserted text is longer.

Secondly, with many word processors you can search for the 
paragraph character (¶). At the end of each paragraph you 
may find two in succession. If so, you can use the procedure 
below. If not, insert an extra one before you begin.

• Select the text to be reformatted.
• Use Find (Search) and Replace to change ¶¶ with 

some other character (e.g. ##). 
• Then Replace single ¶ characters with a space.
• Finally Replace the ## (or whatever character you 

have used) with ¶¶ to complete the reformatting.

Thirdly, you can use that procedure with recent versions of 
Word,  but  there  is  an  easier  way  that  should  work  with 
paragraph  marks,  but  may  not  work  with  line  breaks 
characters(



). 

• Select the text to be reformatted. 

• Go to the Format menu
• Choose AutoFormat.
• Click OK.

In Open- Star- Office you cannot search for the line break or 
paragraph character, but you can use AutoFormat. However, 
it only works with Default paragraph style.

• Choose Tools  and click on AutoCorrect.
• On the Options tab, ensure Combine single line. 

paragraphs if length greater than 50% is selected.
• Click OK.
• Select the text to be reformatted.
• In the Apply Style box on the Formatting bar, 

choose Default.
• Choose Format. 
• Click on AutoFormat.
• Click Apply.
• Select the text to be reformatted.
• In the Apply Style box on the Formatting bar, 

choose the final style for the inserted text.

Lastly, when pasting text in experiment with Paste Special on 
the Edit menu. You may find an option that makes it easier to 
reformat. If so, always use that. 

Index
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Model Park opens

Do you run radio-controlled model cars? Then you will be 
happy to know that Stage 1 of the Lions Goodwood Model 
Park was officially opened recently.

The  President  of  the  Model  Makers  and  Collectors 
Association Inc., Brian Johnson, spoke about the history of 
the park, Bill Wedd spoke on behalf of the Lions and thanked 
the many people and organisations who had contributed to 
development  of  the  park  and  the  Mayor  of  Glenorchy, 
Adriana Taylor, then declared it open, inviting former Mayor, 
Terry Martin MLC, to join her in unveiling the plaque.

Stage 1 consists of the Clubrooms, a gravel track and a sealed 
track. The former Junee Street hall in Chigwell was cut in 
three and moved to the site, where it was reassembled and 
refurbished. Both tracks have ramps for the disabled to reach 
the platforms. 

The  opening  was followed by  demonstration and celebrity 
races, involving the Southern Tasmanian Model Car Club and 
various  celebrities,  including  Ric  Patterson,  Michael 
Hodgman MHA and Lisa Singh MHA. For more information:

http://mmaca.com http://www.stmcc.com.au

Index

Google Earth updates

Towards the end of last month, an update fixed many of the 
holes in the SRTM data used by Google Earth. This greatly 
improves  the  appearance  of  Mt.  Everest,  Matterhorn,  and 
others in South America, Asia, and Europe.

Also included are imagery updates:

• 12 high-resolution cities in Germany (Bayreuth, 
Bochum, Castrop-Rauxel, Fulda, Hof, Mannheim, 
Marburg, Potsdam, Schweinfurt, Siegen, Unna 
Froendenberg, Wuerzburg)

• 6 high-resolution regions in the UK (Bridgend, 
Cleveland, Dundee, Plymouth, Poole, Rochford)

• 31 city updates from Digital Globe
• Entire island of Oahu
• Imagery from individual cities/counties: Grants 

Pass, OR; City of Kent, WA; Salem, OR; Douglas 
County, WA; Hartford County, MD; Jackson 
County, OR; Summit County, OH; 

• Expanded/updated coverage for the states of 
Massachusetts, Rhode Island, Indiana, and Florida

• Darfur
• 66 Islands
• Improved San Francisco Bay area 

Index
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Remove or disable applications

Here,  based  on  Microsoft's  advice,  is  how  to  remove  or 
disable unwanted applications:

• Run  an  antispyware  program,  such  as  Windows 
Defender,  Ad-Aware,  or  AVG  Antispyware 
(Avgas).

• Run an online scan, such as Windows Live OneCare 
safety scanner. These scans are free, but there may 
be  a  charge  for  cleaning  up  –  not  in  the  case  of 
Windows  Live  OneCare,  though,  that  Microsoft 
service  is  completely  free  and  available  at 
http://safety.live.com. 

If  your  antispyware  program and the  scan  don't  solve  the 
problem,  you  might  be  able  to  disable  the  troublemaker 
through  Add-On  Manager  in  Internet  Explorer,  or  the 
corresponding function in  your  chosen browser.  Here's  the 
procedure for Internet Explorer:

1. Open Internet Explorer.
2. On  the  Tools menu,  click  Manage  Add-ons.  (If 

you're using Internet Explorer 7 or Windows Vista, 
click Enable or disable Add-ons.) 

3. In the list of add-ons, look for add-ons you didn't 
accept or don't recognize. Click to select the one you 

want  to  disable,  and  then  click  Disable in  the 
Settings section in the bottom half of the  Manage 
Add-ons box. 

4. Click OK.

Add-ons are programs that extend the capabilities of Internet 
Explorer and other web browsers, and include such functions 
as  toolbars  or  programs  you  can  use  to  make  hotel 
reservations  or  search the Internet.  While  these  are useful, 
most of the functions can be performed without the aid of the 
third  party  toolbar.  Browsers  such  as  Internet  Explorer  7, 
Firefox  and  Opera  come  with  their  own  in-built  search 
facility and you do not need to add a third-party one. Firefox, 
in particular, has a huge range of approved add-ons that can 
provide you with almost any additional feature you want. Be 
safe.  Use  these  in  preference  to  third-party,  advertising-
supported ones.

But  there  are  also  add-ons  you  wouldn't  want  under  any 
circumstances, such as those that redirect your search to their 
own Web site, implant spyware, or change your homepage. 

My advice is to be very careful about adding third party add-
ons unless they come from a site associated with the browser 
(e.g. Firefox extensions) and keep a close eye on what young 
people are doing when they use your computer. That's when 
the less-than-reputable add-ons usually get installed.

Index
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Windows XP boot.ini rebuilding

Here's  something  most  users  can do  from  the  Recovery 
Console in Windows XP. 

Most of us find the  Recovery Console a complete mystery 
because all it offers is a command line prompt. However, if 
you know what to type, you can rebuild the boot.ini file, an 

action  that  can  fix  a  number  of 
problems,  such  as  “hal.dll  file, 
missing or corrupt”. It is also useful 
if you have had to start a Windows 
XP install twice, leaving two entries 
to  select  from  when  booting  up, 
only one of which works.

These instructions come from Fred 
Langa's  invaluable  “Windows 
Secrets  &  Langalist”  newsletter. 
You can subscribe to the newsletter 

at Windows Secrets' sign-up page:

http://windowssecrets.com/links/n8pp7t45iwmgd/50a5d7h 

'Intermittent  problems  can  be  among  the  hardest  to 
troubleshoot. But the simplest thing to do to try to resolve [a 
problem] is to start with XP's Rebuild command. The short  

form of the fix is as follows:

1. Boot from your XP Setup CD and enter the 
Recovery Console*

2. Enter the command attrib -h -r -s c:\boot.ini
3. Delete the file (del c:\boot.ini)
4. Run bootcfg /rebuild
5. Run fixboot

'Those five steps can fix a number of thorny startup issues  
and may be all you need. But if the above is too telegraphic  
for you, you can read fully detailed instructions in [Fred's]  
InformationWeek  article,  "XP's  Little-Known  Rebuild 
Command." Microsoft's official instructions can be found in 
"Description  of  the  Windows  XP  Recovery  Console"  and 
"Recovery Console Tools and Settings." '

If rebuilding boot.ini doesn't fix the problem that you have, 
do  a  search  of  the  Internet,  using  details  from  any  error 
message you have received. 

This  is  always  worth  doing,  as  there  are  often  Microsoft 
articles  dealing  with  the  problem,  as  well  as  articles  by 
various “gurus” just waiting for you to find and read them.

*When you boot your computer from your XP Setup CD, it will stop at a 
screen  giving  the  option  of  repairing  the  installation  from the  Recovery 
Console. Choose this option by pressing 'R'.
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Xandros 4 update

Two new developments have occurred on the Xandros scene. 

The  first  is  the  release  of  version  4.1  in  the  guise  of  a 
business-oriented  desktop  known  as  Xandros  Desktop 

Professional.  For 
$USD99.99  you 
get an installation 
CD,  an 
applications  CD, 
a  300+  page 
manual, a printed 
installation  guide 
and  a  30  minute 
SkypeOut  cou­
pon. Freight from 
USA  to  here  is 
around $USD35.

Existing  users  of  Xandros  products  can  upgrade  to 
Professional  from $USD49.95,  depending on their  existing 
version and whether or not they have Premium membership 
of Xandros Networks.

Professional  includes a 3D interface,  (If  you're waiting for 
Vista,  eat  your heart  out!)  Bluetooth and wireless support, 

Codeweavers Crossover Office to run Microsoft Office and 
other Windows applications, Firefox 2, Evolution groupware 
client, and OpenOffice.org 2.0. It uses kernel version 2.6.18 
and KDE 3.4.2 (Xandros enhanced).

Apart from the special video requirements for the 3D effects, 
Professional will run happily on any PC-compatible having at 
least  a  450  MHz  CPU,  256  MB  of  RAM  and  3  GB  of 
available hard disk space. The minimum RAM is 128 MB 
and hard disk space can be  as  little  as  1.5  GB, but,  as  is 
usually the case, minimum specifications mean performance 
compromises  and  it  is  better  to  have,  or  exceed,  the 
recommended  specification.  As  updates  and  additional 
programs  are  installed  over  the  Internet,  a  broadband 
connection is highly desirable

The second development is the upgrading of Xandros Home 
Premium  through  Service  Pack  1  to  use  the  new  kernel 
version.  Firefox  is  updated  to  version  2.0  and  other 
applications are also updated.

Installation  of  the  updates  is  simple.  Firstly,  click  on  the 
Xandros Networks update and allow it to install. Then click 
on the Service Pack upgrade and allow it to install. You can 
go  on  using  your  computer  while  the  Service  Pack  is 
downloaded.

Xandros  don't  issue  updates  as  frequently  as  some  other 
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distributions,  but,  when they  do,  they  are  fully  tested  and 
usually  perform  well.  However,  always  watch  for  minor 
patches  which  sometimes  follow  an  update  to  correct 
problems noticed on computers which differ from those used 
by beta testers.

Xandros Linux desktop products are now available in three 

main  "flavours",  Home,  Home  Premium,  and  Desktop 
Professional.  Xandros  also  have  Linux  server  products. 
Education discounts are available to qualified purchasers. 

Index

Speed up Windows XP

When you install Windows XP, the setup program enables all 
visual effects that it detects your PC may be able to handle. 
Some of these are really not much use,  other than to slow 
things  down.  By  turning  them  off,  you  can  improve  the 
responsiveness of your system. Here's how in XP Pro:

• Right-click on My Computer and click Properties
• Click on Advanced
• Click on Settings under Performance 
• Disable all visual effects except the last three (and 

optionally Smooth Edges of Screen Fonts)
• Click OK
• Right-click on the desktop and click Properties
• Click the Appearance tab
• Click Effects
• Untick the first two boxes and click OK.

If Windows XP still seems a little sluggish, have a look what 
icons appear  next  to  the  time.  While  antivirus  and certain 
system functions  should  be  there,  some  other  applications 
may be unnecessary. Right-click and exit them. If this results 
in an improvement, you need to stop them from starting when 
booting. Also run your antispyware to clean up any spyware 
that may be slowing your computer.
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Fig. 3: Desktop search - one of the new Professional features
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